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Warnings, Cautions, and Notes

as Used in this Publication

Warning

Warning notices are used in this publication to emphasize that hazardous voltages,
currents, temperatures, or other conditions that could cause personal injury exist in this
equipment or may be associated with its use.

In situations where inattention could cause either personal injury or damage to
equipment, a Warning notice is used.

Caution

Caution notices are used where equipment might be damaged if care is not taken.

Note

Notes merely call attention to information that is especially significant to understanding
and operating the equipment.

This document is based on information available at the time of its publication. While
efforts have been made to be accurate, the information contained herein does not
purport to cover all details or variations in hardware or software, nor to provide for
every possible contingency in connection with installation, operation, or maintenance.
Features may be described herein which are not present in all hardware and software
systems. GE Fanuc Automation assumes no obligation of notice to holders of this
document with respect to changes subsequently made.

GE Fanuc Automation makes no representation or warranty, expressed, implied, or
statutory with respect to, and assumes no responsibility for the accuracy, completeness,
sufficiency, or usefulness of the information contained herein. No warranties of
merchantability or fitness for purpose shall apply.
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Preface

Content of this Manual

Chapter 1. Introduction: Chapter 1
describes the Hand-held Monitor. This
chapter lists catalog numbers and
specifications. It also explains
compatibility between different versions
of the Hand-held Monitor and various
other products.

Chapter 2. Hardware Setup: Chapter 2
gives instructions for powering the HHM,
changing its EPROM, and changing its
battery pack. It also describes how to
install the HHM on a panel, and how to
install a separate HHM connector on a
bus.

Chapter 3. Getting Started: Chapter 3
explains how turn on the Hand-held
Monitor, and how to set up its features for
your application. Chapter 3 also explains
how to test the Hand-held Monitor’s
operation.

Chapter 4. Device Configuration:
Overview: Chapter 4 gives basic
instructions for using the Hand-held
Monitor to configure Genius devices.

Chapter 5. Monitoring the Bus and its
Devices: Chapter 5 explains how to use the
Hand-held Monitor to display data and
status information from other devices on
the bus. It also explains how to clear faults,
switch a dual bus, execute Pulse Testing,
and display the bus scan time.

Chapter 6. Reading CPU Memory:
Chapter 6 explains how to use the HHM
to read the contents of specified memory
locations in CPUs on the bus.

Chapter 7. Error Messages: Chapter 7
defines messages that may be displayed
during HHM startup or operation, or
device configuration.

Related Publications

For more information, refer to these
publications:

Genius 1/0O System User’s Manual
(GEK-90486-1). Reference manual for
system designers, programmers, and
othersinvolved in integrating Genius 1/0
products in a PLC or host computer
environment. This book provides a
system overview, and describes the types
of systems that can be created using
Genius products. Datagrams, Global Data,
and data formats are defined.

GeniusDiscreteand Analog Blocks User’s
Manual (GEK-90486-2). Reference
manual for system designers, operators,
maintenance personnel, and others using
Genius discrete and analog 170 blocks.
This book contains a detailed description,
specifications, installation instructions,
and configuration instructions for all
currently—available discrete and analog
blocks.

Series 90-70 Remote I/O Scanner User’s
Manual (GFK-0579). Reference manual
for the Remote 1/0 Scanner, which
interfaces a drop containing Series 90-70
modules to a Genius bus. Any CPU
capable of controlling the bus can be used
as the host. This book describes the
Remote I/0 Scanner features,
configuration, and operation.

Genius Bus Interface Unit and Field
ProcessorUser’s Manual (GFK-0825).
Reference manual for the Bus Interface
Unit and the Field Processor, which
interface a station containing Field
Control modules to a Genius bus. Any
CPU capable of controlling the bus can be
used as the host. This book describes the
features, configuration, and operation or a
Bus Interface Unit or Field Processor.

FieldControl I/O Modules User’s Manual
(GFK-0826). Reference manual for system
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designers, operators, maintenance
personnel, and others using Field Control
/0 modules. This book contains a
detailed description, specifications, and
installation instructions for all
currently—available 1/0 modules.

Series90™ -70 Bus ControllerUser’s
Manual (GFK-0398). Reference manual
for the Bus Controller, which interfaces a
Genius bus to a Series 90-70 PLC. This
book describes the installation and
operation of the Bus Controller. It also
contains the programming information
needed to interface Genius 1/0 devices to
a Series 90-70 PLC.

Series90™ -30 Bus ControllerUser’s
Manual (GFK-1034). Reference manual
for the Bus Controller, which interfaces a
Genius bus to a Series 90-30 PLC. This
book describes the installation and
operation of the Bus Controller. It also
contains the programming information
needed to interface Genius 1/0 devices to
a Series 90-30 PLC.

SeriesSix™ BusControllerUser’s
Manual (GFK-0171). Reference manual
for the Bus Controller, which interfaces a
Genius bus to a Series Six PLC. This book
describes the installation and operation of
the Bus Controller. It also contains the
programming information needed to
interface Genius 1/0 devices to a Series Six
PLC.

SeriesFive™ BusControllerUser’s
Manual (GFK-0248). Reference manual
for the Bus Controller, which interfaces a
Genius bus to a Series Five PLC. This book

Hand-heldMonitorUser’s Guide — June 1994

describes the installation and operation of
the Bus Controller. It also contains the
programming information needed to
interface Genius I/0 devices to a Series
Five PLC.

Genius I/O PCIM User’s Manual
(GFK-0074). Reference manual for the
PCIM, which interfaces a Genius bus to a
suitable host computer. This book
describes the installation and operation of
the PCIM. It also contains the
programming information needed to
interface Genius I/0 devices to a host
computer.

Genius1/0OSingle-slotPCIM User’s
Manual (GFK-0881). Reference manual
for the Single-slot PCIM, which interfaces
a Genius bus to a suitable host computer.
This book describes the installation and
operation of the PCIM. It also contains the
programming information needed to
interface Genius 1/0 devices to a host
computer.

We Welcome Your Comments
and Suggestions

At GE Fanuc automation, we strive to
produce quality technical documentation.
After you have used this manual, please
take a few moments to complete and
return the Reader’s Comment Card
located on the next page.

Jeanne L. Grimsby

Senior Technical Writer

GFK-0121E
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Chapter Introduction

The Hand-held Monitor (HHM) is a convenient operator
interface device that can be used to set up and monitor a Genius
I/0 and communications system.

The HHM features:
®  An LCD display with four lines of 16 characters each.

GENIUS mon
Hand Held Monitor
OF
GE Fanuc

~)

m  Selectable display language: English, German, French, or
Italian.

m A 20-key sealed-membrane keypad.

m  Akeyswitch that can be used to restrict operator access to
certain functions, as selected for the application.

m  Operation from its battery pack, or by 115 volt AC
or 230 volt AC power. Q
The Hand-held Monitor screen is the operator’s

window to the Genius bus and all of its devices. It can
be used to display:

)b

O 1/0 data for any device on the bus.
Diagnostics.

Bus scan time.

Descriptions of all devices on the bus.

o O O 0O

=

Global Data addresses.
O Memory data from CPUs on the bus.

The Hand-held Monitor can also be used for device configuration, fault clearing, and forcing 170 circuits
and dual bus selection. It can also be set up to prevent the use of any of these capabilities.

A key feature of the Hand-held Monitor is its ability to communicate with 1/0 blocks and to force discrete
andanalog 170, whether or not there is a PLC or computer connected to the bus. This greatly simplifies
system check-out prior to full-scale system operation.

GFK-0121E 1-1



Hand-held Monitor Description

HHM Cable —>

The HHM Keypad

The Hand-held Monitor keypad has three types of keys: function keys (F1 - F4), decimal
keys, and operation keys.

Function Keys: The four keys in the top row (F1, F2, F3, and F4) have functions that

GE Fanuc

GENIUS  mony” |

Hand Held Monitor

cfg

A

!

EEE
)
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EEe
BD0E

change as the display changes.

The bottom line of the screen shows the current functions of these keys. For example:

Decimal Keys: The decimal keys are used to enter numbers and change sign.

F1

F2

=

Mode Select Keyswitch

LCD Display

Function Keys

Decimal Keys

Operation Keys

Connectionfor
Charger/Adapter

F3

F4

nxt prv actv bus

Operation Keys: The four keys on the right side of the keypad are used to control HHM
operations:

Home

A

Menu

displays the Home menu.

displays the previous screen.

Hand-held Monitor User’s Guide — June 1994

Clear

On
Off

clears HHM error messages,
clears Genius faults,
deletes HHM keypad entries.

turns the HHM on or off.

GFK-0121E



GFK-0121E

The HHM Display

The Hand-held Monitor has a 4-line LCD screen. On a new Hand-held Monitor,
displays are in English. The display language can easily be changed to French, German,
or Italian. (Instructions for changing the display language are on page 3-5).

In addition to alphanumeric characters, the display uses the following special characters:

|+  tri-stateinput.

Or Output with Feedback, or block with both inputs and outputs.
4 circuitis forced OFF

1 circuitisforced ON.

(@] relay block pointis forced open.

C relay block pointisforced closed.

Bs  circuitcontrolsaBusSwitching Module.

? reference address or Device Number not yet assigned.

*

reference address is out of range for the presently-selected HHM host.

For a list of other HHM abbreviations and their meanings, select F3 (HELP) from the
HHM Utilities menu.

Keyswitch

The Hand-held Monitor’s keyswitch can be used to restrict access to certain features of
the HHM.

With the key present, the switch can be placed in either “configure” (cfg) or “monitor”
(mon) position.

cfg with the switch in Configure position, all HHM functions are available. In this
mode, the Hand-held Monitor can be configured to determine which of its fea-
tures will be usable once the key is removed.

mon: with the keyswitch in Monitor position, the HHM can monitor bus and block
data. Additional HHM functions, such as clearing faults or configuring 1/0
blocks, can be used in Monitor mode only if the HHM has been set up to permit
their use.

The key must be present to move the switch from Monitor to Configure mode position;
it can only be removed in MON position. Two identical keys are supplied with each
Hand-held Monitor. The key should be removed if system security is a concern.

Accessories

The Hand-held Monitor comes with:

m A sturdy removable leather case. The case has a rear tab with snap closure for
carrying the HHM on a belt. The handle can be pivoted back to stand the
Hand-held Monitor upright on a table.

® A rechargeable battery pack.
® A battery charger/adapter with 8-ft cord.
m  Two keys for the mode-selection keyswitch.

®  Aremovable 5 ft (1.5 meter) coiled communications cable.

Chapter 1 Introduction 1-3



HHM Compatibility

The following table shows which Hand-held Monitor versions are compatible with
specificGenius1/0, Field Control, and related products.

Note that the functionality of an older Hand-held Monitor can be upgraded by replacing
its firmware PROM. (PROM installation instructions are in chapter 2).

Product Product Requires this Hand-
Type Catalog held Monitor \er-
Number sion (or later)

24/48VD@\nalog4 Input/2 Outputblock 1C660BBA020 any
24/48VDQRTD 6 Input block IC660BBA021 IC660HHM501B(v2.0)
24/48VDCThermocouple 6 Input block 1C660BBA023 1IC660HHM501D(v3.5)
24/48VDCCurrent-Source Analog4Input/2Outputblock 1C660BBA024 IC660HHM501E(v3.7)
24/48VDQCCurrent-Source Analog 6 Output block 1C660BBA025 1IC660HHM501G(v4.0)
115VAC Analog4 Input/2 Outputblock 1C660BBA100 any
115VAC/125VD@RTD 6 Input block IC660BBA101 IC660HHM501B(v2.0)
115VAC/125VDCThermocouple 6 Input block IC660BBA103 IC660HHM501D(v3.5)
115VAC/125VDQCurrent-Source Analog4 Input/2 Outputblock 1C660BBA104 IC660HHM501E(v3.7)
115VAC/125VDQCurrent-Source Analog 6 Output block 1C660BBA105 1IC660HHM501G(v4.0)
24/48VDCSourcel6l/0block 1C660BBD020 any
24/48VDCSink161/0block 1C660BBD021 any
24VDCSource161/0block 1C660BBD022 any
24VDCSink161/0block 1C660BBD023 any
12/24VDCSource321/0Oblock 1C660BBD024 IC660HHM501B(v2.0)
5/12/24VDCSink321/0Oblock 1C660BBD025 IC660HHM501B(v2.0)
115VAC81/0block 1C660BBD100 any
115VAC81/0 Low Leakage block 1C660BBD101 any
115VAC 16 Input block 1C660BBD110 IC660HHM501B(v2.0)
115VAC/10-30VDCHigh-SpeedCounterblock,v1.x 1C660BBD120 IC660HHM501D(v3.5)
115VAC/10-30VDCHigh-SpeedCounterblock,v2.0 IC660BBD120D | IC660HHM501G(v4.0)
115/230WAC Relay Normally-closed 16 Output block 1C660BBR100 IC660HHM501B(v2.0)
115/230WAC Relay Normally-open 16 Output block 1C660BBR101 IC660HHM501B(v2.0)
115VAC/125VDC8I1/0OlsolatedBlockwithFailed Switch Diagnostic 1C660BBS100 any
115VAC/125VDC8I/0OlsolatedwithoutFailed Switch Diagnostic 1C660BBS101 any
115-230VAC/125VD@Power TRAC block, v.2.2 or earlier 1IC660BPM100 IC660HHM501D(v3.5)
115-230VAC/125VDCPower TRAC block, v.2.3 IC660BPM100C | IC660HHM501G(v4.0)
Series Five Genius Bus Controller IC655BEM510 1IC660HHM501C(v3.0)
Series 90-70 Genius Bus Controller IC697BEM731 IC660HHM501Hv3.8)
Series Six Genius Bus Controller with Diagnostics 1C660CBB902 any
Series Six Genius Bus Controller without Diagnostics 1C660CBB903 any
Series90-30 GENIUS Communications Module 1C693CMM301 1IC660HHM501C(v3.0)
GENIUS Network Interface (GENI) module IC660ELB905 any
IBM PC Interface Module (PCIM) IC660ELB906 any
GENIUS Network Interface (GENI) module with inverted connector IC660ELB910 any
Series90-70Remote |/O Scanner IC697BEM733 1IC660HHM501G(v4.0)
24/48VDCBusSwitchingModule (BSM) 1C660BSMO021 any
115VAC/125VDCBusSwitchingModule (BSM) IC660BSM115
Field Control products (all) 1C670XXXXXX 1IC660HHM501)(v4.6)

1-4
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HHM Specifications

Operatingtemperature 0-60 C(32-140 F)
Storagetemperature -40 to +70 C(-40 to 158 F)
Humidity 5-95% (non-condensing)
Weight: withoutcase 1.31bs (0.6 Kg)

withcase 1.81bs (0.8Kg)
Size (HxWxD): withoutcase 8.00”x”3.75x 1.25 (cmx)

with case 10.857x4.30”x2.25”

Required AC power (for battery charger) | 115/230¥AC 15%, 47-63 Hz

(16-hourcharging period for IC660BPM500B.
8-hour charging period for IC660BPM500A, now
discontinued.)

Fully chargedoperation 6 hours

Displaycharacters 4 lines each of 16 LCD (0.2” - 5 mm high)

Keyboard 20 sealed keys with tactile feedback

Features PerformsGeniusl/Oblockconfiguration,monitors
1/0 dataon Geniusbus, displaysdiagnosticin-
formation.

Displaylanguage English, German, French, or Italian

Drop Test Survives drop from 4 feet (1.2 meters) to concrete

floor landing on any surface or corner without af-
fectingitsoperation.

DataRates 153.6 Kbaud standard, 153.5 Kbaud extended, 76.8
Kbaud, 38.4 Kbaud

Ordering Information

Description Catalog Number
Hand-HeldMonitor (includes all items listed below) 1C660HHM501
CablefromHHMto /0 Block 1IC660HHCO005
Battery Pack 1C660BPM500
Battery Charger 1C660BCM501

Optional Accessories

External HHM Connector: A panel-mountable or DIN rail-mountable HHM connector
(catalog number 44A736310-001-R001) is available. It can be used to provide a
permanent HHM connection point on a Genius bus. See chapter 2 for a description.

230VVAC Power Adapter: An optional 230VAC Power Adapter (IC660MCA512) can be
used to connect the Hand-held Monitor Charger to variety of 230 VAC power outlets by
means of a standard computer cable (not supplied). See chapter 2 for a description.

Extra HHM Keys: For applications requiring extra keys for the Hand-held Monitor, a
group of five sets can be ordered separately. The catalog number is IC660MKS511.

GFK-0121E Chapter 1 Introduction 1-5



Chapter Hardware Setup

Power for the Hand-held Monitor

The Hand-held Monitor can be operated using its built-in battery, or connected to either
115 volt or 230 volt AC power. A battery pack must always be installed to operate the HHM,
even when using AC power.

An optional 230VAC Power Adapter can be used to connect the Hand-held Monitor Charger
to variety of 230 VAC power outlets. See page 2-2 for more information.

Charging the Battery Pack for AC Operation

To operate the HHM using AC power, if the battery pack is new or has become fully
discharged by operating the HHM on battery power, it must be charged for at least 20
minutes. If it is necessary to restore temporary operation before charging is complete:

®  Plug the adapter cable into the HHM.

®  Wait 15 seconds and power up the HHM. It may be necessary to remove the battery pack
for 15 seconds, then reinstall it.

Note that continually using the Hand-held Monitor in AC mode for an extended period of
time causes the battery pack to deteriorate. After up to two years of AC operation of the
HHM, the battery pack may not be able to accept enough charge to operate the HHM
independently. However, it can still be used for AC operation.

Selecting 120 VAC or 230 VAC

Before plugging the adapter into AC power to operate or charge the Hand-held Monitor,
be sure the switch at the base of the adapter is correctly set to match the incoming
power (120 volts AC or 230 volts AC).

120V

poﬂﬁon\\\‘

230V
position

The Hand-held Monitor will operate while the adapter is connected.

GFK-0121E 2-1



Using the 230VAC Power Adapter

The optional 230VAC Power Adapter (IC660MCA512) can be used to connect the Hand-
held Monitor Charger to variety of 230 VAC power outlets by means of a standard com-
puter cable (not supplied).

The Adapter has a receptacle on the top for the Hand-held Monitor Charger and an IEC
320 receptacle on the side for the computer cable.

HHM Charger receptacle in
top of Adapter

IEC 320 receptacle in
side of Adapter

Instructions

1. Set the power selection switch on the Hand-held Monitor Charger to the 230V position.

A
2ov

position

2. Plug the Hand-held Monitor Charger into the top receptacle on the Power Adapter
unit.

3. Plug the computer cable into the IEC receptacle on side of the Power Adapter unit.
4. Connect the computer cable to a suitable 230VAC power source.

During normal operation, it is best to connect and disconnect the cable at the outlet, not
at the Adapter.

Hand-held Monitor User’s Guide — June 1994 GFK-0121E
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Battery Operation

The HHM'’s battery pack provides up to 6 hours of operation. To maximize battery life,
allow the battery to discharge fully between charges. The battery should be allowed to
fully discharge once a month.

Low Battery Power

Low battery power may cause this message:

**LOW BATTERY®**
**HHM HALTED®**
Please Recharge

Or the display may blank, or two black lines may appear briefly. Low battery power
suspends the current operation.

Charging the Battery Pack

When you receive a new Hand-held Monitor, its battery pack is not charged. Before
using a new battery pack to power the HHM for the first time, charge it by plugging the
adapter into a power source for 24 hours. After this initial charging, subsequent
rechanges will require only 16 hours.

Maintaining spare battery packs will allow the HHM to operate using one battery pack
while another is being charged.

If the battery pack won’t take a charge, it usually indicates a faulty battery pack, not a
faulty Hand-held Monitor. Try another battery pack. Replacement (uncharged) battery
packs are available.

If a battery pack is left uncharged for a long time, it may be necessary to remove the
battery pack from the HHM and charge it while removed for up to 15 minutes.

Replacing the Battery Pack

To replace the battery pack, use a Phillips screwdriver (size 0 or 1) to release the retaining
screw at the bottom of the HHM. Slide the battery pack out, insert another, and tighten
the screw.

Automatic Shutoff

To conserve power, the Hand-held Monitor automatically shuts off 10 minutes after the
last key is pressed. For applications where continual operation is preferred, the
automatic shutoff feature can be disabled. See page 3-5 for more information.

Chapter 2 Hardware Setup 2-3



Changing the PROM

2-4

New features can be added to upgrade a Hand-held Monitor by replacing its PROM as

described below.

To prevent possible damage to the Hand-held Monitor, this operation should be
performed in an area equipped with suitable electrostatic discharge protection.

Caution

1. Ifthe HHM is connected to AC power, disconnect it.

2. Remove the HHM battery pack as described on the previous page.

3. On the front of the Hand-held Monitor, remove the two Phillips-head screws located
near the 7 and HOME keys.

4. Gently raise the keyboard up from the bottom to release the lip between the

keyboard and the display.

5. Once this lip is free, open the keyboard to the right, as illustrated below. It is not

necessary to remove the ribbon connector.

Install PROM
with notch to
right as shown

6. Remove the old PROM.

GENIUS mon

Hand Held Monitor
cfg
GE Fanuc

mmllyn

©) ©

/

1

] O
QQuu e
OO0
OO0
OO0

er can be used instead, carefully working from side to side.

Hand-held Monitor User’s Guide — June 1994

If you don’t have a PROM extraction tool, a small screwdriv-
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7. If necessary, bend the pins on the PROM so they line up properly with the holes in
the socket. Bend the pins by pressing each side against a clean desk or table top as
shown below. If possible, a conductive mat should be used.

uuugmmj

46024

e |

Conductive mat

8. Insert the EPROM or Battery-Backed RAM into the socket.

IMPORTANT: Inserting the PROM backward can damage the Micro PLC and
destroy the PROM.

Newer PROMs may be physically longer, but all PROMs must be inserted flush with
the left edge of the socket, with the notch toward the ribbon connector.

9. Reposition the keyboard in its lip and tighten the two screws.

10. Reinstall the battery pack.

Chapter 2 Hardware Setup
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Permanent Installation

2-6

If the Hand-held Monitor is to be installed using the metal bracket provided, follow the
instructions below. Do not install the HHM yet if it will be used to configure 1/O blocks.

The mounting bracket provided can be used to install the Hand-held Monitor behind a
panel. You will need to make a cutout in the panel for the HHM (see next page).

You will also need to install a connector for the Hand-held Monitor within reach of the
HHM’s cable. The extra D-shell connector provided with the Hand-held Monitor
requires a panel cutout, with the bus cable and Hand-held Monitor located on the
opposite sides of the panel (see page 2-8).

An optional panel-mountable or DIN rail-mountable connector is also available. It does
not require a cutout. See page 2-9 for details.

Back of HHM 1 Behind Panel
Bracket Optional HHM
Connector

Bus In
Bus Out

To Power Source

Configuring a Permanently-installed HHM

Ordinarily, a Hand-held Monitor installed on a panel serves as an operator station. Its
configuration may be different from that of a portable HHM.

m |ts Device Number must be changed from O to some other number.
®  Automatic shutoff may be disabled.
m |/0 block configuration and other features may also be disabled.

After the HHM is configured, its keyswitch should be placed in MON position, and the
key removed.

Hand-held Monitor User’s Guide — June 1994 GFK-0121E
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HHM Installation Instructions

1. Select a suitable location for the HHM. Environmental specifications are listed on
page 1-5. The location must have 115 VAC or 230 VAC power.

2. Cutan opening 3.75" (9.53cm) wide x 8” (20.32cm) high in the panel. Drill four
mounting holes as shown below.

4.38in
=< (11.13cm)

3.75in
€ (9.53cm) P V

-
— LT 1.00in (2.54cm)

& Sy
Cutout

|

|

|

|

| 6.00in
| (15.24cm)
|

|

|

\
PR |
— — 1.00in (2.54cm)

A

E;44444444444

3. Attach the bracket to the HHM with the screws, washers, and lockwashers provided.

\ @)
— A\
Vol o
(4) holes for
mounting on
panel
9
O
I
@) (2) holes for mounting to
— back of Hand-held Monitor

4. Using appropriate hardware (not provided), mount the HHM and bracket in the
cutout.

5. Connect the power cord to the HHM, and connect the signal cable to the connector.

Chapter 2 Hardware Setup 2-7
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Installing the D-Shell HHM Connector

Follow the instructions below if you are installing the supplied D-shell connector on the
bus.

1. Using the mounting plate as a template, cut an opening in the panel for the mating
connector. Also drill two holes for the mounting hardware.

2. Attach the mounting plate and mating connector to the panel using the mounting
hardware supplied.

3. Secure the two ends* of the serial bus cable to the back of the panel using strain
relief brackets.

4. Strip the ends of the wires. Twist the two Serial 1 wires together and attach them to
pin 5 of the connector. Twist the Serial 2 wires together and attach them to pin 9.
Similarly; attach the Shield wire(s)* to pin 4.

The following illustration shows connections for incoming and outgoing serial bus
cable. As with other devices, the HHM connector may be at either end of its bus. If it
is, there will only be one bus cable attached.

Bus Strain Bus . 42240
Cable Reliefs  Cable Mounting ad2240c
Hardware
n Hand-held
Mating Mounting Monitor
Connector  Plate Connector
-1 64—~ 6--=0
! S
[
[ | —
[
0 | —
[
| | —
— —
——1]
N\ —
| 04| o --=0

Mounting Surface
(rear view)

When making bus connections, the maximum exposed length of bare wires should
be two inches. For added protection, each shield drain wire should be insulated with
spaghetti tubing to prevent the Shield In and Shield Out wires from touching each
other.

* If the HHM connector is at either end of its bus, it is necessary to install an
appropriate terminating resistor across the Serial 1 and Serial 2 wires. The Genius 1/0
System and Communications User’s Manual lists appropriate terminating resistors for
each recommended bus cable type.
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Installing a Separate Hand-held Monitor Connector

You can add a connector to the bus for a permanently-mounted Hand-held Monitor, or
to provide an additional attachment point for a portable HHM.

The unit shown below (catalog number 44A736310-001-R001) provides a Hand-held
Monitor connector and serial bus terminals.

.51in 1.673in 46357
. - o
1.27 cm 4.249cm
A
4 - Hand-held Monitor
- Connector
/
VAP aERN
</ ~
AN
AN
A

Panel Mounting Ear

2.834in
7.198 cm R\

AN
SN
QDD /\W
X1 X2| SA SB \\\//J/
QOO QO - Serial Bus Terminals
Tl < X1  Serial 1
X2  Serial 2
SA Shield In
shown at 100% of actual size SB  Shield Out

Mounting the HHM Connector

This unit can be easily mounted on a rail such as a standard 35mm (shown below) or
15mm DIN rail. The panel-mounting ears are not used if the unit is installed on a DIN
rail.

46358

D[ - 35mm DIN rail

D ]

—

[ D ~—— (Removable) DIN rail
B Mounting Feet

side view: shown at 50% of actual size

Alternatively, it can be installed directly on a panel using screws through its mounting
ears. The DIN rail feet on the back of the unit are removed when the unit is
panel-mounted.
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Making the Bus Connections

The HHM connector has two sets of terminals; one for incoming cable and the other for
outgoing cable.

Connect the Serial 1, Serial 2, and Shield In terminal of either connector to the previous
device. Connect the Serial 1, Serial 2, and Shield Out terminal of the other connector to
the next device.

When making bus connections, the maximum exposed length of bare wires should be
two inches. For added protection, each shield drain wire should be insulated with
spaghetti tubing to prevent the Shield In and Shield Out wires from touching each other.

The following illustration shows connections for incoming and outgoing serial bus cable.
As with other devices, the HHM connector may be at either end of its bus. If it is, there
will only be one bus cable attached.

46366

Bus In

Bus Out

ﬁé

QOOD
o

A SB
)

SA Shield In
SB  Shield Out

DO D] e Sena
X1 X2 SA SB

Aswith other devices, if the HHM Connector is at either end of its bus, install an
appropriate terminating resistor across the Serial 1 and Serial 2 terminals. The Genius 1/0
System and Communications User’s Manual lists appropriate terminating resistors for each
recommended bus cable type.
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Chapter Getting Started

This chapter explains how to:
Turn on the Hand-Held Monitor

GFK-0121E

O

O

Set the HHM Baud Rate
Display the Home Menu

Change the Hand-held Monitor’s configuration:

m}
m}
m}
m}
m}
m}
m}
m}
m}

the HHM Device Number

the HHM Display Language

the Host CPU

automatic shutoff

ability to Change Block ID Parameters

ability to Change the Baud Rate of Devices on the Bus
ability to Configure Devices on the Bus

ability to Forcel/OCircuits

ability to Clear Faults

Test the operation of the Hand-held Monitor.

O

O

O

Display an alphabetical list of definitions for the definitions used on the HHM screen.

the Keypad
the Display Screen
the Internal Electronics



Turning on the Hand-Held Monitor

With the battery pack charged, or with the HHM

connected to a suitable AC power source, press the

ON/Offkey to turn the Hand-held Monitor on.

Caution

Do not connect or disconnect the
HHM to/from another device or con-
nector while it is ON.

Connecting or disconnecting the
HHM while it is ON may disrupt
communications on the bus.

Each time you turn on the Hand-held Monitor, it
executes a brief self-test.

GENIUS HHM (version)
COPR. (date)

GE Fanuc N.A.
SELFTEST WORKING

Setting the HHM Baud Rate

Before the HHM completes the self-test, this
screen appears:

HHM BAUD RATE

ACTIVE=153.6K ST

MUST MATCH BUS
chng o k

1. If the baud rates match, press F4 (OKk).

If the baud rates do not match, press F2
(Change) instead. The HHM screen changes to
allow you to select a different baud rate:

HHM BAUD RATE

A C T 1V E = (baudrate)

PROG =(baudrate)
tgl entr o k

A. With the key in CFG position, press F2
(Toggle). The selection changes to 76.8K,
38.4K, 153.6K extended, and back to 153.6K
standard.

B. When the correct baud rate appears on line
3, press F3 (Enter). Press F4 (OKk) to return
to the first baud rate screen.

2. Press F4 (OKk) to display the Home menu.

Powerup Error Messages

Chapter 7 lists error messages that may appear at
powerup.

Sometimes, an error message appears although
the HHM has powered up normally.

POWERUP ERROR #4 or #5 may be caused by
excessive noise on the bus, or by an attempt to use
different baud rates on the same bus.

It shows the baud rate that is currently set up for
the Hand-held Monitor. The baud rate must be the
same for all devices on a bus.

3-2
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Displaying the Home Menu

This is the Hand-held Monitor’s Home menu:

F1:HHM UTILITIES
F2:ANALYZE
F3:CONFIGURATION
FA:DEVICE MEMORY

lower-level screen.

B. Pressing the Home key or DMenu key from a

Use the Home menu to get to any other HHM

function, as shown below.

Notice that different screens appear, depending on

Display the Home menu by either:
A. Pressing F4 (Ok) from the first baud rate

screen, or

with the HHM.

the type of device that is currently communicating

The Main HHM Screens

F1: HHM UTILITIES
F2: ANALYZE

F3: CONFIGURATION
F4: DEVICE MEMORY

F1

F2

F3

F1: HHM CONFIG
F2:SELF-TEST

F1: MONITOR BLOCK
F2: MNTR/CTRL REF

F1: PROG BLOCK ID
F2: CONFIG BLOCK

F3: HELP F3: BLOCK/BUS STS F3: COPY CONFIG
F4: PULSE TEST
F1 F1 F1
HHM CONFIG REFS [¢] PROG BLOCK ID
| | BLOCKNO. 0 | | 34567890 | | o
O00OO0OO0O0O BLOCK NO.
chng nxt A1000111 ref blk nxt

See page 3-4 for
instructions.
F2

F1: KEYPAD TEST
F2: DISPLAY TEST
F3: TEST INTRNALS
F4:

See page 3-7 for
instructions.

F3

L (helpscreens)

GFK-0121E

See page 5-4 for
instructions.

F2

MNTR/CNTL o
| | STATE: 0

NO FAULTS

> on off reles

See page 5-9 for
instructions.

F3

REFS [¢]
DC16K 15 v2.0ACT
FORCED, NO FAULTS
nxt prv actv bus

See page 5-2 for
instructions.

F4

PULSE TEST

REFS 0

NO FAULTS
exec

See page 5-17 for
instructions.

See page 4-4 for
instructions.
F2

(individualfeature
— configuration
screens)

See Geniusl/O
Blocks Manual or
individualblock
manual for
instructions.

F3

COPY CONFIG
FROM : TO:

chng entr

See page 4-6 for
instructions.

For Most
Genius Devices

F2

F1: MONITOR
F2: CONFIGURATION

F1

F1 Monitor 1/O
F2:Faults

F3 Previous Menu

See page 5-15 for
instructions.

F2

F1: GENIUS CONFIG
F2: Module Config

F3: Previous Menu

See page 4-7 for
instructions.

For Field
Control

F4

DEVICE MEMORY #
(reference)

tgl chng entr SBA

Chapter 3 Getting Started

See chapter 6 for
instructions.
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Configuring the Hand-held Monitor

You can change the following operating
characteristics of the Hand-held Monitor:

PLC reference format.

153.6 Kbaud “standard” baud rate.
Device Number set to 0.

English language displays.

Shutdown after 10 minutes of inactivity.
1/0 block configuration enabled.
I/Ocircuitforcingenabled.

Fault clearing enabled.

Select F1 (HHM Utilities) from the Home menu to
access the HHM Utilities menu:

F1:HHM CONFIG
F2:HHM SELF TEST
F3:HELP

F 4

To change the configuration of the Hand-held
Monitor, select F1 (HHM Config) from the HHM
Utilities menu.

Note
The HHM key must be in the key-
switch, turned to CFG position.

After setting up the configuration, you can prevent
changes by turning the keyswitch to the MON
position and removing the key.

3-4
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Changing the HHM Device Number

The Device Number (serial bus address) assigned
to the Hand-held Monitor appears on line 2 of the
first HHM configuration screen.

HHM CONFIG
BLOCK NO. O

chng nxt

Each device on a Genius bus must have a unique
serial bus address number. A new HHM has
number 0. If multiple HHMs will be used on the
same bus, each of them must be assigned a
different Device Number.

If you want to change the HHM Device Number,
follow these steps:

m  Press the ON key. Go to the Home menu. Se-
lect F1 (HHM Utilities), then F1 (HHM Config).

®  From the HHM Configure menu, press F2
(Change) to clear the existing Device Number.
Enter the new number and press F3 (Enter).

Pressing F4 from the buad rate screen will advance
you through additional HHM configuration
screens. Press Home if you want to return to the
Home menu, or use the DMenu key to go back to
the previous screen.

GFK-0121E
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Changing the HHM Display Language

The next display shows the current language
selection.

HHM CONFIG
LANGUAGE
ENGLISH
tgl entr nxt

Press F2 (TGL) to change the display language
(French, German, Italian, English). Press F3
(Enter) to save the change.

Selecting the Host CPU

The next display shows the Hand-held Monitor’s
host CPU selection. The choices are: Series Six,
Series Five,PCIM/QBIM/GENI, orSeries90.

SELECT HOST CPU
SERIES SIX

To change the host CPU type, press the F2 (TGL)
key, then press F3 (Enter).

Chapter 3 Getting Started

Enabling/Disabling Automatic Shutoff

The next screen shows whether automatic shutoff
is selected.

AUTO OFF =
ENABLED

IOmin

This feature conserves battery power by shutting
off the Hand-held Monitor 10 minutes after the
last key press. To change the current selection,
press F2 (Toggle), then F3 (Enter).

Enabling/Disabling the Ability to Change Block
ID Parameters

The next display shows whether the Hand-held
Monitor is able to configure the Block Number
(serial bus address) of bus devices, as well as the
170 circuit mix of some types of /0O blocks.

CHNG BLK ID
ENABLED

This selection also determines whether the HHM
is able to assign the Reference Addressofl/O
blocks, or change the 1/0 mapping of a Remote
1/0 Scanner (for the modules in its remote drop).

To enable or disable this capability, press F2 (TLG),
then F3 (Enter).



Enabling/Disabling the Ability to Change the
Baud Rate of Devices on the Bus
The next configuration screen shows whether the

HHM is able to change the baud rate of bus
devices.

CHNG BLK BAUD
ENABLED

To change the current selection, press F2 (Toggle),
then press F3 (Enter).

Enabling/Disabling the Ability to Configure
Devices on the Bus
The next display shows whether the HHM is able

to change the other configurable features of bus
devices.

CHNG BLK CONFIG
ENABLED

Enabling/Disabling the Ability to Force 1/0
Circuits

The next display shows whether the HHM can be
used to force 1/0 circuits.

CIRCUIT
ENABLED

FORCING

To change the current selection, press F2 (Toggle),
then press F3 (enter).
Enabling/Disabling the Ability to Clear Faults

The next display shows whether the HHM can
clear faults on bus devices.

CLEAR BLK
ENABLED

FAULTS

To change the current selection, press F2 (Toggle)
then press F3 (Enter).
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Testing Operation of the Hand-held Monitor

If you want to test the Hand-held Monitor display,
keypad, or internal electronics, select F2 (HHM
SELF-TEST) from the HHM Utilities menu. This
menu of tests appears:

F1:KEYPAD TEST

F2:DISPLAY TEST
F3:TEST INTRNALS
F 4:

Testing the Keypad
Press F1 (KEYPAD TEST). The HHM prompts:

KEYPAD TEST
STRIKE ANY KEY
KEY =

MON/CFG KEY=CFG

®  Press any key you want to test. Each key press
is shown on the display. The HOME, D
MENU, and ON/OFF keys are tested by their
operation.

m  To test keyswitch operation, turn the key and
observe the bottom line of the display.

m Press D MENU to perform another test, or
press HOME to return to the Home menu.

Testing the Display Screen

PressF2 (DISPLAY TEST) from the HHM Utilities
menu. The screen first displays uppercase letters
and special characters:

DISPLAY TEST
ABCDEFGHIJKLMNOP
QRSTUVWZYD12345
6789:>?2—-./1 _09 I1

Next, a screen of lowercase letters appears,
followed by a continuous test pattern, which
checks pixel operation. When the test pattern is
finished, press DMENU to perform another HHM
test, or press HOME to return to the Home menu.

Chapter 3 Getting Started

Testing the Internal Electronics

Press F3 (TEST INTRNALS) from the Self-Test
menu. After a moment, the HHM displays:

TEST INTRNALS

SELFTEST WORKING
exec

If an error occurs, one of the following messages
will appear instead.

E:PROCESSORFAIL
E:RAMFAILURE
E:EPROMFAILURE
E:EEPROMFAILURE
E:COMM ERROR

Press the Clear key and try the test again. If the
message returns, replace the HHM. Otherwise,
continue.

An EEPROM failure will not prevent use of the
Hand-held Monitor. However, the HHM will not be
able to retain changes to its default configuration
through a power cycle.

The COMM ERROR message may indicate that
the Hand-held Monitor is not attached to a
correctly-terminated bus.



Chapter Device Configuration Overview

The Hand-held Monitor can be used to configure (establish the operating characteristics for) a wide
variety of other devices. Some configurable devices are:

®  Genius 1/0 Blocks, High-speed Counter Blocks, and PowerTRAC Blocks
m the Series 90-70 Remote I/0 Scanner and its remote drop
®m  Field Control stations.

The Hand-held Monitor displays a unique set of configuration screens for each type of configurable
device.

Because of the wide assortment of configuration features provided by the HHM, it has not been possible

to include them all here. You should refer to the more detailed configuration instructions in the User’s
Manual for the type of device you are configuring.
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Online or Offline Configuration

Devices can be configured before or after
installation on a properly-terminated serial bus. If
a new device is to be added to an existing bus
running at a baud rate other than 153.6 Kbaud
standard, the device must first be configured
offline. Be careful adding new devices to existing
systems. Be sure the baud rate configured for the
new device matches that of the system - never mix
baud rates on a bus.

Online Configuration

When configuring a device on an operating bus,
the Hand-held Monitor must be the ONLY HHM
plugged into a device on the bus. If devices are
configured online, the HHM automatically check
for PLC reference address conflicts.

Offline Configuration

It may be most convenient to configure devices
off-line at a central location. Each device will need
to be connected to an appropriate source of power
and to earth ground. To prepare a device for
off-line configuration:

1. Connecta 75 ohm resistor across the Serial 1
and Serial 2 terminals, or use the 75 ohm
terminator plug (IC660BLM508).

2. Attach a grounding strap to the device’s
ground screw. Be sure that the strap is
connected to earth ground.

a42468

Attach
Ground
Strap

t@@

Terminator
Plug

‘&@&55@&55@& 560‘5 [SIISISIORSINCIE NI &H‘

3. Wire the device to the power source and apply
power.

Warnings

If the device is not properly grounded,
hazardous voltages may exist. Death or
injury may result.

DO NOT TOUCH the connectors or
wiring after powering up the device.
Hazardous voltages exist, and death or
injury may result.

Starting Configuration

Note: To assign a serial bus address, the
Hand-held Monitor must be directly attached to
the device being configured. Additional features
can be configured with the Hand-held Monitor
connected at any point on the bus. In that case, the
device being configured must be selected as the
active device (on the Block/Bus Status screen).

1. Begin with the Hand-held Monitor turned off.
Attach the HHM to the device (see below) or
to another bus connection point.

L —uo
[ 5

e e e e e e e e e e

no J

2. Turn the Hand-held Monitor on. After the
HHM completes its powerup sequence, the
Home menu appears. The Hand-held
Monitor’s Change Block Configuration option
must be enabled to complete the instructions
in this section. For a new device, the HHM’s
Change Block ID and Change Block Baud
options must also be enabled.
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Displaying the Configuration Menus

The illustration below shows how to reach the
HHM’s device configuration menus from the Main

Menu.

m  For all devices, you will need to select F3 (Con-

All Devices

figuration) then F1 (Program Block ID) to con-
figure a block’s required features.

O Device Number (serial bus address).
o I/Otypeforinput/outputblocks.

O CPU references.

O Baud rate.

For new blocks, this must be done first.

To configure Genius blocks, select F3 (Configu-
ration) from the Main Menu, then F2 (Config-
ure Block) to view and modify other features.
Detailed configuration instructions for each
type of device are provided in its User’s Manual.

You can use F3 (Copy Configuration) to copy a
configuration from one block on the same bus
to another.

To configure a remote drop, continue from the
Program Block ID screens to enter the remote
map (1/0 References) and Drop ID. Then go to

the Configure Block screens to configure re-

dundancy and Configuration Protection.

For a Field Control device, select either F2
(Analyze) or F3 (Configuration) from the Main
Menu. The HHM will then display a special set
of screens for Field Control. (The currently-ac-
tive device must be the Field Control device for
these screens to appear. See page 4-7 if you
need instructions to select the active device).

If the message E: CONFIG PROTECT appears,
you can remove Configuration Protection by:

1.

Going through the configuration screens to
reach the Configuration Protection screen.

Pressing F2 (Toggle) to select either DISABLED
orENABLED.

3. Pressing F3 (Enter) to save the selection.

Pressing F4 (Next) to go to the first configura-
tion display, D MENU to return to the Configu-
ration menu, or HOME to return to the Home
menu.

F1:HHMUTILITIES

Displaying the HHM
Configuration Menus

F2:ANALYZE
F3:CONFIGURATION

F4:DEVICE MEMORY

F3 F2 or F3
|
F1:PROG BLOCKID F1:Monitor

F2:CONFIG BLOCK
F3:COPY CONFIG
F4:

F1 F2

F3

F2:Configuration

PROG BLOCK ID

COPY CONFIG

I / O (device references) FROM: nTO:
BLOCKNO.(device)
ref blk nxt chng entr
Field Control
Devices

Configure a Remote
Map

Configure an
I/0 Block
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Remote 1/0O Scanner Genius Blocks

and Remote I/O Scanner
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F1:GENIUS CONFIG
F2:Module Config

F3:Previous Menu




Completing the Program Block ID Screens

Select F1 (Program Block ID) from the
Configuration menu to complete the mandatory
part of a device’s configuration. (The HHM’s
CHNG BLK ID capability must be enabled).

When the HHM is set up for a PLC host, the
Program Block ID screen looks like this:

PROG BLOCK 1ID
/0 (device references)

BLOCK NO. (device #)
ref blk nxt

If there are ?  symbols on the screen, the
reference address and/or Device Number have not
yet been configured. If there are * symbols on the
screen, a reference address was previously
assigned, but is out of range for the host CPU
currently set up for the HHM. If this happens,
check the host CPU setup in the HHM Utilities.

When the HHM is set up foraPCIM/QBIM/GENI
host, references are not used. Instead, the second
line describes the device:

PROG BLOCK 1ID
ISOL 8 (device #)

BLOCK NO. (device #)
ref blk nxt

To Enter or Change the Device Number: the
Hand-held Monitor must be connected directly to
the device.

1. Press F2 (blk). Then, enter the intended num-
ber (1-30). If you make a mistake, press F2
twice again, then enter the correct number.

2. Press the F3 (Enter) key. If the device is on-line
and the number has already been used, an er-
ror message appears.
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To Complete the Program Block ID Screen: The
Program Block ID screen is used to configure
additional features for some devices. These vary
from device to device; you should refer to the
device’s User’s Manual if you need more
information.

To Change the Device’s Baud Rate: press F4
(Next) from the Program Block ID screen. (The
HHM’s CHNG BLK BAUD capability must be
enabled).

SELECT BAUD RATE

ACTIVE=153.6K ST

PROG =153.6K ST
tgl entr nxt

The bus will not operate unless all devices are set for the
same baud rate. Check the baud rate before
introducing blocks onto an operating bus.

®  To change the device’s baud rate, press F2
(Toggle), then press F3 (Enter).

m  Cycle power to all devices on the bus at the
same time to use the new baud rate.

To Set the 1/0 Map for a Remote 1/O Scanner:
The next screen is used to assign data types and
lengths for a Series 90-70 Remote 1/0 Scanner. See
the next page.
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Configuring a Remote 1/0 Scanner

After selecting the baud rate, the next Program
Block ID screen is used to assign data types and
lengths for a Series 90-70 Remote 1/0 Scanner.

PROG REMOTE MAP

% |

LENGTH(PTS)

tgl ref send nxt
Configuration Notes

The Remote I/O Scanner User’s Manual explains
remote drop configuration in detail. You should
use it as a reference during remote drop
configuration.

Also, look over the information below. Especially,
note that it is not always possible or desirable to
use a HHM for remote drop configuration.

m |f the remote drop includes any Analog Expan-
der Modules, Logicmaster 90 must be used for
configuration; do not use a HHM.

®  When a remote drop is configured with a
HHM, all 1/0 modules will operate in default
mode; module options can only be configured with
the Logicmaster 90-70 software.

®  Unless the Remote I/0 Scanner is configuration
protected, pressing F3 (send) from the Remote
Map configuration screen causes the HHM to
automatically configure the remote drop. This
configuration will REPLACE any existingl/O
configuration (including one entered using Lo-
gicmaster 90-70), and return I/0 module op-
tions to their original defaults.

®  Remote drops configured with Logicmaster
90-70 are automatically protected. Please check
carefully before removing configuration protec-
tion with a Hand-held Monitor.

®  The Hand-held Monitor automatically creates a
configuration for a nine-slot rack, regardless of
the actual rack size. If the remote drop has a
five-slot rack, the HHM will later assume that
there are unfilled slots. If this is a problem, Lo-
gicmaster 90-70 can be used for configuration,
or to edit an automatic configuration done with
a Hand-held Monitor. Then, the configuration
can be stored to the Remote I/0 Scanner.

Configuring the Remote Drop

To configure the remote drop with the HHM:

1. Enter a starting address and length for: %I (dis-
crete inputs), %Q (discrete outputs), %Al (ana-
log inputs), %AQ (analog outputs) on the
screen shown at left. The data lengths must
not add up to more than 128 bytes of inputs
and 128 bytes or outputs. If they do, an error
message will appear when you attempt to send
the data to the Remote I/0 Scanner.

2. Next, press F2 (drop) and enter a Remote Drop
ID (between 16 and 254).

PROG REMOTE MAP
DROP 1ID
tgl drp send nxt

3. Press the F3 (send) key to download these
selections to the Remote 1/0 Scanner.

Note: Do not perform this step if you want to
preserve a configuration entered using the Lo-
gicmaster software.

The HHM configures the 1/0 references of Se-
ries 90-70 1/0 modules (only) in the remote
drop. It assigns references in ascending order,
starting with the slot next to the Remote 1/0
Scanner. The leftmost module of each type (%l,
%0Q, %Al, or %AQ) in the rack receives the first
available reference of the appropriate type.

4. Press F4 (nxt) to go to the Program Block ID
screen.

5. After completing these screens, press F2 (Con-
figure Block) to complete the Genius configura-
tion screens, or to display information about
the 170 modules in the remote drop.

The module description screens that appear
during the configuration sequence are read-
only; boards cannot be configured here.

Go through these block description screens to
configure:

BSM Present

BSM Controller

CPU Redundancy
Configuration Protection
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Configuring Genius Blocks

To configure individual features of a Genius block,
the block must be the *“active” device.

Selecting the Active Device

1. From the Analyze menu, select F3 (Block/Bus
Status).

2. Press F1 (Next) or F2 (Previous), to reach the
device’s description screen.

3. When the desired device appears, press F3 (Ac-
tive) to make it the active device. (On a dual
bus, the HHM must be on the same bus as the
active block. If it is not, either move the HHM
or force the bus selection as described on
page 5-3).

4. Press D MENU twice to return to the Main
Menu.

ConfiguringBlock Features

Select F3 (Configuration), then F2 (Config Block).
For Genius blocks, the HHM shows the first
configuration display. For example:

PULSE TEST q
R E F S (blockeferences)
ENABLED

tgl entr nxt

The HHM shows the feature to be configured (in
the example above, it is the Pulse Test option). It
also shows the current status of that feature.

When the Hand-held Monitor is set up for a PLC
host, line 2 shows the references assigned to the
device being configured. If there are ? symbols on
the screen, the device’s reference address has not
yet been configured. If there are * symbols on the
screen, a reference address was previously
assigned, but it is out of range for the host CPU
currently set up for the Hand-held Monitor. If this
happens, check the host CPU setup in the HHM
Utilities.

When the HHM is set up foraPCIM/QBIM/GENI
host, line 2 shows the device type and Device
Number (serial bus address) instead.

Because there are so many different device
configuration screens, it is not possible to show
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them all here. You should refer to the User’s
Manual for the device you are configuring for
descriptions of its configuration screens and
detailed instructions for completing them.

Configuration Instructions

1. To advance through the HHM configuration
displays making changes as needed, use the F4
(Nxt)key. You can pass through feature dis-
plays without making entries.

2. To change a feature, use the TGL and CHNG
keys to select choices or enter other values. On
screens used to enter individual 1/0 circuit op-
tions, use the F1 ( >) key to choose a circuit,
then select the option using the TGL or CHNG
key. On some displays, you can enter new val-
ues from the keypad.

3. Press the F3 (Enter) key to save each change.

Copying a Configuration

If there are similar devices on an operating bus,
you can use the Copy Configuration feature to
copy the configuration from one to the another.
Both of the devices must have a Device Number
already configured, and they must be operating at
the same baud rate. The device to be copied TO
must not be Configuration Protected.

The device to be copied FROM must be the active
device (move the HHM to that block or select it
from the Block/Bus Status screen).

1. To begin, press F3 (Copy Configuration) from
the Configuration menu. The HHM shows:

COPY CONFIG
FROM: n TO:

chng entr

2. The Device Number of the active device ap-
pears next to the word FROM. Enter the De-
vice Number of the device being copied TO.
Press F3 (Enter).

3. Press the F4 (Execute) key. The configuration is
copied.
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Configuring Field Control Station

1. From the HHM Main Menu, display the special
set of menus for Field Control.

A. If the Bus Interface Unit or Field Processor is
the current-selected device, press F2 (ana-
lyze) twice or F3 then F2.

B. Ifitis NOT the currently-selected device:

m  Select F2 (analyze) then F3 (Block/Bus
Status).

®  Press the F1 (nxt) or F2 (prev) key repeat-
edly to reach the serial bus address of the
BIU or Field Processor. Press F3 to make it
the active device. Then, press AMenu, fol-
lowed by F2 (MonitorLControl Ref).

F1:Monitor
F2:Configuration

From this menu, press F2 (Configuration). This
menu appears:

F1:GENIUS CONFIG
F2:Module Config

F3:Previous Menu

m  Press F1to configure the BIU/Field Processor.

m  Press F2 to configure individual modules.

Change the Bus Address

When you press F1 (Genius Configuration) from
the Configuration menu, the HHM shows the
serial bus address previously configured for the
BIU or Field Processor:

Device SBA
14
Prv > entr

If the bus address is correct, press F2 to go on.

Note: If a BIU or Field Processor has a Serial Bus
Address conflict on an operating bus, it will not

scan the modules in the station until the fault is

cleared.

1. If you want to change the address, enter the
new address using the keypad.

2. Press F4 (entr). An error message appears if
the number has been used for another device.

Select a PLC Reference Address
If the host is not a Series Six PLC or Series Five
PLC, no entry is necessary here.

If the host is a Series Six PLC or Series Five PLC,
assign an 170 or register reference address.

Stat Thl
00000

Addr

< > 106 entr

shows reference type

1. Use the F3 key to toggle the selection of Series
Six1/Omemory, Series Five |l/O memory, or
register memory. (See the BIU/Field Processor
User’s Manual for information about memory
usage in the Series Five and Series Six PLC).

If /0 memory is used, the amount required is
equal to the number of bits of discrete data
PLUS analog data. Each analog reference used
consumes 16 points.

If register memory is used, an amount is re-
quired that is equal to the total number of bytes
of input data PLUS all of the output data

2. Key in the number of the block’s beginning 1/0
or register reference. This may be:

SeriesSix1/0 1to0 993
Series Fivel/0O 1 to 2041
Registers 1to 16383

3. Press the F4 (Entr) key.

Configure Additional Features

On the screens that follow, select these features:

Fault Reporting

Genius bus redundancy

BSM Controller

Output default time (for redundancy)

CPU redundancy

Duplex redundancy: default mode for outputs
Configuration protection
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Configuring Individual Field Control Modules

Go to the Field Control configuration menu:

F1:GENIUS CONFIG
F2:Module Config

F2:Previous Menu

From this menu, press F2 to configure the
individual modules in the station.

Disable the I/O Scan

While you configure the modules in the station,

you may want to disable 1/0 scanning. (The Bus
Interface Unit or Field Processor begins scanning
I/0 as soon as it is powered up).

10 Scan
DISABLED *

Prv > tgl entr

When the I/0 scan is disabled, previously
unconfigured module inputs and outputs default
to 0. For previously-configured modules, inputs
and outputs either default or hold their last state
or value, as configured.

1. If you want to change the present selection,
press F3 (tgl).

2. Press F4 (entr). If you want to go to the next
screen without changing the selection, press F2

(>).
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Configure Data Addresses and Lengths

The next screens are used to assign the starting
addresses and lengths for I, then Q, then Al, then
AQ data.

If the host is a Series 90 PLC, these should
correspond to the memory assignments made for
the BIU or Field Processor during PLC configuration.

If the host is a Series Six or Series Five PLC, only
the length selected here is used; the entry made
on the starting address screen is not used by the
PLC. For those PLC types, the starting address was
assigned on an earlier screen.

1. For each data type, enter a starting address for
discrete input data (I). For example:

Blk Map Start 1
| O00O01
< > entr

2. Press F4 to accept the value. Then, enter a
length in bits for | data. For example:

Blk Map Lngth
64

< > entr

3. Press F4 (entr) to accept the value.

4. Continue as above, entering starting addresses
and lengths for the other data types.

The lengths entered must not add up to more
than 128 bytes of inputs (discrete + analog)
and 128 bytes of outputs (discrete + analog).

5. Press F1 ( >) after entering the length for AQ
data (the fourth data type).

If you changed any starting address or length
entries, the HHM displays this screen:

Map has changed
Accept?

noyes

6. To accept the changes and continue to the next
menu, press F4 (yes).
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Add Modules and Assign References

The first module configuration screen looks like this:

Rack Slot
number number

RO:S1 EMPTY

< > tglread

Use F1 and F2 to display
another slot (module)

The Rack Number is always 0.
The Slot Number refers to the location of the
module relative to the BIU or Field Processor.

Read a Module Identification

If there is a module in the currently-selected slot,
pressing F4 (read) from the “empty slot” screen
brings up the module identification screen:

RO:S1 Mod
Discrete Out 16

?
type: ~ Module
type

tgl entr

m |f you want to change the module type dis-
played, press F3 (tgl) to list other module types.

®  To accept the module type, press F4 (entr).

Select a Module Type

If a module is not present in the selected slot, press
F3 (tgl) to select Generic 1/0 or Special 1/0. Then
press F4 (entr).

RO:S1
Genericl/O

I/O type?

tgl entr

m  Use the F3 (tgl) key again to go through the
module names.

®  When the correct module name appears, press
F4 (entr).

Assign I/O References for the Module

After you “accept” a module into the slot, a screen
like this appears:

RO:S1
I

116

entr

Specify the 1/0 references to be used by the
module. For most applications, you can simply
havethe BIU/Field Processor assign the next
available references in that memory type.

A. To assign the next available references, just
press F4 (entr).

B. If you want to assign specific references, enter
the starting address. Press F4 (entr).

Module references are automatically assigned by
the BIU or Field Processor based on its configured
data addresses and the number of points
appropriate for the module type.

Editing a Module Configuration

To edit the module’s configuration, press F4 (zoom).
Refer to the module configuration instructions in the
BIU/Field Processor User’s Manual.

Delete an Existing Module Configuration

To delete the configuration of the module in the
present slot, press F3 (delete) then F4 (enter). Note
that this removes the entire module configuration.

Configuring Module Features

Configure additional module features as described in
the BIU/Field Processor User’s Manual. For example:

®  Change the module’s reference address.
®  Module Fault Reporting (discrete)

m Default inputs (or outputs) or Hold Last State
(discrete and analog)

Channel Fault Reporting (analog)
Channel Active (analog)

Input Current/\6ltage Ranges (analog)
Input or output scaling (analog)

Alam thresholds (analog)

Output default values (analog)
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Chapter

Monitoring the Bus and its Devices

This chapter explains how to perform monitoring and control operations with the Hand-held Monitor.

Displaying Information About Bus Devices (page 5-2).

0 Selecting the Active Device (page 5-2).

0 Clearing Faults (page 5-3).

Display foraBus Controller(page 5-3).
Monitoringthe Bus Status (page 5-3).
SwitchingaDual Bus (page 5-3).
MonitoringaGeniusBlock (page 5-4).

o Discrete 1O and Input Blocks (page 5-4).
Discrete Relay Output Blocks (page 5-5).
Analog Blocks (page 5-5).

RTD or Thermocouple Blocks (page 5-5).
High-speed Counter Block (page 5-6).
PowerTRAC Block (page 5-7).

I O o R o IR |

Monitoring and Operation

MonitoringandControlling Individual Circuitson a
GeniusBlock (page 5-8).

O Discrete, Relay, High-speed Counter Block (p. 5-9).
Forcing an Input or Output (page 5-9).
Clearing Circuit Faults (page 5-9).

0 Analog, RTD, or Thermocouple Block (page 5-10).
Forcing an Analog Value (page 5-10).

Clearing Circuit Faults (page 5-10).
PowerTRAC Block (page 5-11).

Forcing PowerTRAC Data (page 5-12).
Diagnostics (page 5-12).

O

Monitoring/Controlling Remote Drop Data (page 5-13).
Forcing a Circuit (page 5-14).

Displaying and Clearing Faults (page 5-14).
Monitoring/Controlling Field Control Data (page 5-15).
ForcingAUnforcing the Reference (p 5-15).
Displaying and Clearing Faults (page 5-16).

Pulse Testing Outputs on Discrete Blocks (page 5-17).

F1:HHM UTILITIES
F2:ANALYZE
F3:CONFIGURATION

HHM Menus F4:DEVICE MEMORY
F2 or F3
| (Field Control)
F1:MONITOR BLOCK F1:Monitor
F2:MNTR/CNTL REF “Confi :
F3:BLOCK/BUS STS F2:Configuration
F4:PULSE TEST
F1 (Genius) | \—\ |
REF S(block references) q F4 (Genius) F1:Monitor I/O
F2:Fault
34 ;6 7q8| 9 Oq 9 q Pulse Test autts
AS 101 1 0 0 1 discrete outputs F3:Previous Menu
F2(Genius) | | F3 (All Devices)
MNTR 441- 464A REFS (device references) 9
12: 19370 DC16K 15 v2.0ACT Ast_e/egth‘?
NO FAULTS FORCED,NO FAULTS < Activelevice
> force reles nxt prv actv bus here

SERIAL BUS STATS
ACTV DEVICES= 7
SCAN TIME= 10ms
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Displaying Information About Bus Devices

Select F3 (Block/Bus Status) from the Analyze
menu to:

m  Display the references assigned to any device.
m  Display the revision level of any device.

m Display the description and Global Data ad-
dress of a bus controller.

m Display the fault status of a Genius block or
Remote I/0 Scanner (remote drop).

m  Select the active device.
m  Clear all faults on the active device.
m  Access the Bus Status display.

This screen provides a quick way to check for faults
and forced circuits before starting up a system.

Block/Bus Status Displays for Bus Devices

Example displays are shown below. (Display format
for bus controllers is shown on the next page).

Genius Block (discrete)

REFS (devicaeferences) 9

DC16K 15 v2. OACT

FORCED,NO FAULTS

nxt prv actv bus
Remote 1/0 Scanner

REFS * * G

RIO 15 v3.5ACT

NO FORCE,FAULTS
nxt prv actv bus

BIU/Field Processor
REFS * * q

fldpr 2 O v1. OACT
NO FORCE
nxt prv actv bus

Line 1 shows the 1/O references used by the device.
If * symbols appear instead of references, the
device’s references are incorrect for the type of host
CPU currently set up for the HHM. For example, if
a device is assigned to Series Six registers, and the
HHM is set up for a Series 90 host, the HHM will
display * symbols instead of references.
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Line 1 also provides information about the device
currently being displayed:

I = Inputblock

O = Outputblock

Q = Blockwithbothinputsand outputs

A = Analog,RTD or Thermocoupleblock

G = PowerTRACDblockorRemotel/0O Scanner

Line 2 identifies the device and shows its serial bus
address (also called its Device Number or block
number), and its revision level.

Line 3 shows whether the device presently has
any forces or faults. If the device is a Field Control
BIU or Field Processor, however, the presence of
faults is not indicated on this screen.

Selecting Another Device

Press F1 (Next) or F2 (Previous) as needed to
display information about other device.

Note: Poor bus conditions may cause the HHM to
skip (not display) a device that is present on the
bus. Try moving the HHM to a different
connector on the bus. Occasio